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Introduction 
 

Century Programmer is QubicaAMF’s Lane Machine Program Development 
System for Windows for use with 100% IBM compatible PCs.  Use this software 
and your computer to create, modify, view, download, upload, and store lane 
conditioning programs for use with your QubicaAMF programmable lane machine. 
This user’s guide is intended to help you install Century Programmer on your 
system, teach you how to use Century Programmer, and provide a written reference 
that can aid in using Century Programmer. 
 
 
System Requirements 
 

•  Microsoft Windows version 3.1 or higher 
•  VGA color display 
•  Mouse 
•  EEPROM version 3.18 or higher in your lane machine 
 
 
Before You Begin 
 

This document does not cover Windows operations, nor does it cover the details of 
lane conditioning or the details of how to use your QubicaAMF lane machine’s 
programmable control.  For information on installing Windows, see your Windows 
documentation.  If you are unfamiliar with the use of, or the terminology associated 
with, the various features of your Windows® operating system, review Chapter 3 of 
this manual before proceeding. 
 
To install Century Programmer, follow the instructions in the Installing Century 
Programmer™ section of this manual. 
 
   
Symbols and Conventions 
 

Century Programmer documentation uses a few special symbols and conventions, 
which are discussed below, to help you distinguish between keys you press and text 
you type.  You can use the mouse or the keyboard for most actions in Century 
Programmer. Whenever possible, instructions are provided for both the mouse and 
the keyboard. 
 

•  Words within brackets < > are the names of selectable menu items and drop-down 
buttons that you can click on with your mouse or are the names of keyboard keys 
to be pressed to initiate an action, to view a screen, or to bring up a dialog box. 



 
 

FM-0060  Revision F 

2

•  Words in italics are references to the names of screens, dialog boxes, keyboard 
keys, drop-down buttons, etc. that do not require any user action such as 
clicking on them with the mouse. 

•  Words within quotation marks (“”) are words that must be typed on your 
computer’s keyboard.  Type these words exactly as shown, including spaces and 
punctuation marks, if any.  Type only what is within the quotation marks, but do 
not include the quotation marks themselves. 

 
 
The Keyboard 
 

The keys on your keyboard may not be labeled exactly as they are in this manual.  All 
keyboard key names are shown using capital letters. For example, the Control key is 
shown as CTRL and the Escape key is shown as ESC.  An instruction to press the 
escape key is shown in brackets as – Press <ESC>.  An instruction referencing the 
escape key is shown in italics as – The ESC key can be used to exit a dialog box and 
return to the main program screen. 
 
 
Product Support 
 
If you have a question about Century Programmer, first consult this user's guide.  If 
you cannot find the answer to your question, contact QubicaAMF Customer Service 
at 866-460-7263. 
 
If you call, you should be sitting in front of your computer with Windows running 
Century Programmer.  You should have this manual at hand, and you should be 
ready to provide the following information: 
•  The version number of Windows and the version number of Century 

Programmer 
•  The type of hardware you are using, including network hardware 
•  A description of what happened and what you were doing when the problem 

occurred 
•  The exact wording of any message that appeared on your computer’s screen 
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Installing Century Programmer 
 

1. Start Microsoft® Windows®.

2. Insert the Century Programmer TM cd into the cd tray of your computer and then close 
the tray.

3. The installation procedure will automatically start. If it does not start automatically, 
browse to the appropriate letter drive for the cd and double click on 
SetupCPW31T.exe. This will start the installation procedure for you. 

 
Note: There might be a noticeably long pause while the program is gathering the needed 
information about your system. Figure 1-1 shows a picture of the screen that will be 
displayed during the initial setup sequence. 
 

 
 

Figure 1-1 
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4. The welcome screen in Figure 1-2 displays basic greeting information. Click on the 
<Next> button. 

 

 
 

Figure 1-2 
 

5. There are two different choices for installation as seen in Figure 1-3. For the 
purposes of this manual, the Standard Setup will be used. Make sure Standard Setup 
is selected and click the <Next> button. If using the Advanced Setup, select the radio 
button next to it and then click the <Next> button. The Advanced Setup requires the 
use of a specific password to allow the program to continue installation. If the 
password is not entered correctly after three attempts, the installation will end.  

 

 
 

Figure 1-3 
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6. The next screen displays the information for insuring that Adobe Acrobat Reader is 
installed on your computer. If you have version 4.0 or lower currently installed, 
please install the free Reader available on the cd. Figure 1-4 shows the information 
about Adobe Acrobat Reader. Click on the <Next> button. 

 

 
 

Figure 1-4 
 

7. The screen that follows displays copyright and general information about installing 
the program properly (Figure 1-5). It is advised that all Windows programs currently 
running should be closed before proceeding any further in the installation. Once this 
has been done, click <Next>. 

 

 
 

Figure 1-5 
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8. There are several different files that can be installed that are for fluid monitoring and 
oil consumption. These files require the use of Adobe Acrobat Reader 5.0 or higher 
which is included on the cd. It is recommended that all of the checkboxes remain 
checked for this part of the installation as shown in Figure 1-6. Click the <Next> 
button. 

 

 
 

Figure 1-6 
 

9. At this point, you must choose which type of lane machine is being used. The default 
selection is the first item which includes the HVO Summit S Series as shown in 
Figure 1-7. Make any changes if necessary and click on the <Next> button. 

 

 
 

Figure 1-7 
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10. Figure 1-8 shows the different machines that fall under the default selection for 
Figure 1-7. The default for Figure 1-8 is the HVO Summit S Series and is shown 
below. Make any changes if necessary and click on the <Next> button. 

 

 
 

Figure 1-8 
 

11. The next set of options asks for information about your lanes. Choose the option that 
best fits the lanes that you have. The Factory Default is already chosen for you as 
shown in Figure 1-9. Choosing Factory Default yields the same installation results as 
choosing Domestic Synthetic Lanes and should only be used if you are unsure what 
lane type you have. Your choice can be changed by reinstalling the program later if 
needed. Once the appropriate selection has been made, click on the <Next> button. 

 

 
 

Figure 1-9 
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12. The next set of options allows you to specify which manuals that you would like to 

have loaded to your computer (Figure 1-10). All of these manuals require Adobe 
Acrobat Reader 5.0 or higher which is provided for you on the cd if needed. By 
default, all the manuals will be loaded on the computer unless unchecked. It is 
recommended to keep the default settings and click on the <Next> button. Refer to 
the manuals included with your lane machine for the most recent information. 

 

 
 

Figure 1-10 
 

13. Figures 1-11, 1-12, 1-13, and 1-14 show screens that have text boxes to type in basic 
information about your bowling center. Please fill in each box with your information 
and click the <Next> button after each screen is complete. 

 

 
 

Figure 1-11 
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Figure 1-12 
 

 
 
 

Figure 1-13 
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Figure 1-14 
 

14. The next section of options asks for a location to install the program and supporting 
files. The default location is shown in the textbox in Figure 1-15 but may be changed 
either by typing a new location or using the browse button. Click the <Next> button 
to proceed to the next step. 

 

 
 

Figure 1-15 
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15. Figure 1-16 shows the folder location into which the program will place shortcut 
icons. The default folder is listed in the textbox and is recommended as the location 
for the shortcuts. Click on the <Next> button to continue. 

 

 
 

Figure 1-16 
 

16. The computer now has enough information to complete the installation process. Click 
on the <Install> button as shown in Figure 1-17 to finish the installation. 

 

 
 

Figure 1-17 
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17. Century ProgrammerTM is now installed on your computer. The screen in Figure 1-18 
shows an address and phone number that are used for software registration. Once you 
click the <Finish> button, a notepad will open with information that needs to be sent 
to QubicaAMF. You may choose to send it either by fax or by mail.  

 

 
 

Figure 1-18 
 

18. Figure 1-19 shows an example of the registration information that comes up on the 
screen after clicking the <Finish> button mentioned in step 17. Please print out your 
file that opens up so you can fax it or sent it through the mail to QubicaAMF (If you 
do not have a printer installed on the computer, save the file to a floppy disk and print 
it from one that does).  

 

 
 

Figure 1-19
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Using Century Programmer™ 
 
This chapter will walk you through the features of the Century Programmer™. 
Note: some screens may appear somewhat different than those presented here 
depending on the version of Windows you are using. 
 
Opening a Data File 
 
Start Century Programmer™ by clicking <Start>, <Programs>, <Programmer 
3.1.6>, <Programmer 3.1>. The following initial screen will appear. 

 

 
Press <ENTER> or click on the <OK> button.   
The following screen will appear. 
       

 
The information that makes up the lane machine’s programs is stored in data files.  
Century Programmer TM provides a set of 20 lane conditioning programs that can be 
customized by the user and saved under different filenames.  In order to begin 
working with programs for your lane machine, you must open a data file.  To select a 
program data file, click <File><Open>.  The File Open dialog box will appear as 
shown on the next page. 
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If necessary, click on the drop-down arrow button at the right of the List files of type 
box and choose the appropriate machine type by clicking on the corresponding item 
on the list.  Silver Bullet® Magnum users should choose either <Silver Bullet 
Magnum> or <Magnum 6>, as applicable. The Magnum 6 file is designed for use 
with Magnum lane machines equipped with version 8.0 or higher operating software, 
which allows for individual oil tank control.    
 
After making your selection from the list, you are presented with a list of one or more 
files that are specific to the machine you have selected.  Click on one of the filenames 
(such as factory.hvo) in the large File name: box.  This action causes the file to be 
selected and listed in the small File name: box, and allows you to open the file.  This 
file (factory.hvo) is a program data file and contains the 20 factory-supplied lane 
conditioning programs. The other files in the list, if any, each contain up to 20 lane 
conditioning programs that have been designed to address specific conditions you 
may encounter in your bowling center. These files are read-only files, and you will 
not be able to save changes to them.  In order to save any changes, you must save 
them using a new filename.  This will preserve the original factory-supplied files.  
 
Click on the <OK> button to open the file.  A screen similar to the one shown below 
will appear. 
 
 
 
 
 
 
 
 
 
 

HVO Summit 
Magnum 6 
Silver Bullet Magnum 
Silver Bullet 
PC 
Gemini Plus 
Scheduler 
All Files (* *)
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This is the HVO Summit program work screen for lane conditioning program #1.  
Each of the 20 programs can be displayed by Century Programmer™ as shown on the 
previous page. 
 
The work screen is somewhat different for the PC™, Gemini Plus™, Gemini Silver 
Bullet®, and the Silver Bullet® Magnum with version 7.x operating software.  The 
examples in this guide show screens associated with the HVO Summit. The screens 
associated with the Silver Bullet® Magnum with version 8.0 operating software are 
similar to the Summit’s.  While not all lane machines have all of the features 
discussed here, these program work screens contain all of the features that are 
common to the other QubicaAMF lane machines. 
 
 

Introduction to the Work Screen 
 

Each work screen represents an individual lane conditioning program.  There are 
basically six parts to the work screen: 
•  Current File and Program Identifiers 
•  Buffer and Oil Settings 
•  Stripping and Cleaner Flow Settings 
•  Short Run Settings 
•  Speed Settings 
•  Download and Save Section 
 
Selecting a Program to be Edited 
 

The first area of the work screen to address is the Current File and Program Identifiers 
section, shown below. 
 
 
 
 
 
 
 
 
 
 
 
 
 

For this example, the current file is FACTORY.HVO.  The current program is 
displayed in the box below the Toolbar buttons, and in this example is Program #1.  
The current program number can be changed by clicking on the <Up> or <Down > 
arrow to the right of the program number or by highlighting the number and entering 
a new number from your computer’s keyboard.   
 
For HVO Summit machines, there is a Name box below the Program # box.  The 
Name box is initially empty.  You can click inside this box and then type in a 

Program Number 

User Programmable 
Program Name 

Current Filename 
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descriptive program name to help you identify this program from others.  When you 
print this file, the name that you give it will also show up on the data sheet.  As stated 
previously, the files provided with Century Programmer™ are read-only files, so you 
will have to save any existing file that you modify or name under a different filename.  
 
Buffer Settings 
 

The second area of the work screen is the Buffer Settings and Oil Settings section. 
The Buffer Mode determines whether the buffer runs when the machine is traveling in 
the forward direction, the reverse direction, both directions, or not at all (see below). 
A separate determination can be made for each of the two available passes. 

 
To adjust the Buffer Mode setting, click on the Pass 1 Buffer Mode <Drop-down> 
button.  Scroll through the list, and select the desired option (see below).  Do this for 
both passes.  These selections are independent of each other and may be different. 
 

 

After setting the Buffer Mode, you must set the forward and reverse distances, as 
applicable, for each direction of each pass.  The forward distance is the distance the 
buffer will run while in contact with the lane surface when the machine travels in the 
forward direction.  The reverse distance is the distance from the foul line that the 
buffer will first contact the lane surface and begin to run when traveling in the reverse 
direction.  If a distance setting is not required by the selected Buffer Mode (e.g. the 
Buffer Mode is off), the number box for that pass will be dimmed indicating that it is 
not active and cannot be changed.  To set or change the buffer distance, tab to or click 
on the applicable distance box, and click on the <Up> or <Down> arrow button or 
enter the number from your computer’s keyboard. 
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When the Buffer Mode is set for either the first or second pass, the Oil Mode also 
automatically changes to the same mode as the buffer.  This occurs so that the Oil 
Mode is consistent with the Buffer Mode.  You can, however, change the Oil Mode to 
a different setting if this is desired.  Century Programmer™ will not allow you to 
make an incompatible selection. 
 
Oil Settings 
 

The Oil Mode determines whether the machine oils in the forward direction, reverse 
direction, both directions, or not at all. You set the Oil Mode and oil distances the 
same way you make the buffer settings.   
 

 
For HVO Summit machines and Magnum machines equipped with version 8.0 or 
higher operating software, the six oil tanks can be operated independently of each 
other. Each tank is identified as either left or right – inside, track, or outside. Each 
setpoint is the distance from the foul line that the corresponding tank will disengage 
from the transfer roller stopping the transfer of oil to the transfer roller when traveling 
in the forward direction, or will engage the transfer roller starting the transfer of oil 
when traveling in the reverse direction.  Each setting for each pass and direction can 
be different from the others.  This opens a whole new vista for creating oil profiles.  
 
For other machines, the six oil tanks are divided into three groups: Outer, Track, and 
Center.  Each group consists of two tanks, one left and one right, that operate 
together.  The outer distance is the distance from the foul line that the outer tanks will 
disengage from the transfer roller when traveling in the forward direction or will 
engage the transfer roller when traveling in the reverse direction.  The track and 
center tanks function in the same manner as the outer tanks except that the distance 
setpoint for each group can be different.   
 
The only restriction is that the oil distances cannot be set higher than the buffer 
distance, since the buffer must be operating to transfer oil to the lane surface.  If you 
set the oil distance greater than the buffer distance, you will not be able to save the 
changes to the program, and you will receive a message that states that the buffer and 
oil settings are inconsistent when you attempt to save the program. 
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The Transfer Rate % setpoint determines the rate at which oil is transferred from the 
oil tank wicks to the buffer brush. The higher the setting, the higher the oil transfer 
rate.  This is accomplished by operating the variable speed transfer roller motor 
between 1% and 100% of its maximum speed as determined by this setting.  To adjust 
this setpoint, click on the <Up> or <Down> arrow to the right of the Transfer Rate % 
number box, or highlight the number and enter the new setpoint directly from you 
computer’s keyboard.  This setting can be different for the forward and reverse 
directions of each pass. 
 
Stripping and Vacuum Settings 
 

The Stripping Mode is selected by clicking on the drop-down button to the right of the 
stripping Mode setpoint box and selecting the desired mode.  The choices are Off, 
Full, or Back.  Selecting Off turns off stripping and disables the vacuum, cleaner pad, 
and cleaner flow settings (cleaner flow is discussed later). 
 

 
 
If Full is selected, the machine will strip the lane from the foul line to a point on the 
lane determined by the Cleaner Pad Distance setpoint.  The maximum distance is 63 
feet. 
 
Back means that only the back area of the lane will be stripped.  Selecting the Back 
mode allows you to set the Start distance, which is the distance from the foul line to 
the point where stripping will begin.  The Start distance is disabled in the other 
stripping modes. 
 
To change the Start distance, first choose the <BACK> Mode and then click on the 
<Up> or <Down> arrow at the right of the Start box to enter the setpoint, or highlight 
the existing number in the Start box and enter the new setpoint directly from your 
computer’s keyboard. 
 
The Cleaner Pad Distance is the distance from the foul line to where the cleaner pad 
picks up off the lane surface during a stripping operation.  Cleaner flow is turned off 
at this point, but the vacuum head remains in contact with the lane surface until the 
machine reaches the end of the lane. 
 
There are two choices for the Vacuum Mode: On Start or On Plug.  In the On Start 
mode, the vacuum motor starts when the machine’s start button is pressed to begin a 
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lane conditioning program.  The vacuum motor remains on until the machine returns 
to the foul line at the conclusion of the first pass for that lane, at which time the 
vacuum motor stops.  In the On Plug mode the vacuum motor starts just as is does in 
the On Start mode, but remains on until power is removed from the machine.  To 
select the Vacuum Mode, click on the <Drop-down> button at the right side of the 
Vacuum mode setpoint box and select the desired mode. 
 
Cleaner Flow Settings 
 

The HVO Summit is designed to allow the use of different cleaner flow rates for 
stripping the conditioned, or in-oil, area and for stripping the back lane area, and can 
apply these two different rates during the same pass.  Since the back area of the lane 
usually contains less oil than the oiled area, less cleaner is needed to strip this part of 
the lane. 
 
To change these setpoints, click on the <Up> or <Down> arrow buttons at the right 
side of the In oil and Back lane setpoint boxes, or highlight the setpoint and enter the 

new setting directly from your computer’s keyboard.    
The setpoint is adjustable from 1% to 100% of the 
maximum cleaner flow rate.   
 
When the machine is set to strip-only, the Back Lane 

flow rate is used to strip the entire lane surface from the foul line to the Cleaner Pad 
Distance setting. 
 
Short Run 
 

With Short Run turned off, the machine will travel the full length of the lane when 
running a lane conditioning program before returning to the foul line.  When turned 
on, Short Run overrides the lane conditioning program’s distance settings and directs 
the machine to stop and begin the reverse pass (or return to the foul line if there is no 
reverse pass run in the program) when the machine reaches the Short Run Turn-
around Distance.   
 
To turn Short Run on or off, click on the Short Run Mode <Drop-down> button and 
select the desired mode.  To set the Turn-around Distance, first turn Short Run ON.  
Next, click on the Turn-around Distance <Up> or <Down> arrow button, or highlight 

the current setpoint and enter the new number directly 
from your computer’s keyboard.  The Short Run Mode 
must be ON in order to make this setpoint change. 
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Speed Settings 
 

There are nine speed settings associated with the operation of the HVO Summit.  Each 
of the machine functions of stripping, conditioning, and traveling (which is machine 
movement while neither stripping nor conditioning) can be set to one of three speeds 
(low, medium, or high), and each of these speeds is different depending on the 
function (see the Speeds Table below). 
 

Machine Stripping Conditioning Traveling 

HVO Summit 
H - 4.8 fps 
M - 3.7 fps 
L - 2.1 fps 

H - 3.7 fps 
M - 2.1 fps 
L - 0.7 fps 

H - 6.2 fps 
M - 5.6 fps 
L - 4.8 fps 

Table 1, Machine Speeds 
 
The speed associated with a particular function can be different for each direction of 
each pass of a lane conditioning program.  For example, you may choose to condition 
on pass 1 forward (P1F) at the slowest speed (L), and then for pass 1 reverse change 
the conditioning speed to medium (M).  If there is a second pass in the lane 
conditioning program, the speeds for that pass can also be different.  Silver Bullet® 
Magnum speeds are somewhat different from those listed here. 
 
To assign a speed setting to a function, click anywhere on the <Speed Settings> 
button shown below. 
 

 
 
The following screen will appear: 
 

 
 
To set the speed of a machine function, click on a <Drop-down> button and choose 
High, Medium, or Low from the menu.  Repeat as necessary for the remaining 
functions and passes.  When finished, click <OK> or press <ENTER>.  To exit 
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without making any speed changes, click <Cancel>.  As with all of the program 
parameters described in this chapter, the speed selections can be different for each 
lane conditioning program. 
 
Saving a New or Modified Data File 
 

Because FACTORY.HVO (as well as the other factory-supplied Programmer files) is a 
read-only file, you will not be able to save any changes you have made to it under the 
existing filename.  In order to save your new worksheet, you must save it using a 
different filename. Note: when naming a file, you may not use more than eight (8) 
characters for the filename. Try the following example. 
 
Click on the <SAVE> button or select <SAVE AS> from the command line’s File 
drop-down menu. Do NOT use the SAVE AS NEW button.  The File Save As dialog 
box appears.   

 
Press <BACKSPACE> to clear the current filename, and then type “tutorial.hvo”.  
Click <OK> or press <ENTER>.  This will save all 20 factory.hvo program data 
worksheets (lane conditioning programs) under the filename tutorial.hvo.  You should 
do this and use the newly created file to try out the features of Century 
Programmer™.  Before editing a lane conditioning program (worksheet), you can 
name it and save it under its current program number or you can assign it any other 
program number from 1 to 20. To save a copy of a program within an existing work 
file, click on the <Save As New> button.  The Save As New Program Number dialog 
box appears. 
 

 
 
 
 
 
 
 

 

 

 

 

1 - Used 
2 - Used 
3 - Used 
4 - Used 
5 - Used 
6 - Used 
7 - Used 
8 - Used 
9 - Used 
10 - Used 
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Click on the <Drop-down> arrow button and select the desired program number 
destination.  Choosing a number that is different from the current program number 
will result in the chosen program being overwritten by the current program.  If 
changes to a program are made before clicking on the <Save As New> button, then 
the original program and the destination program will both have the changes that were 
made.  
 
 

 
1   2* 3   4   5   6   7   8   9   10   11   12   13   14   15   16   17   18   19   20  
 
For example, the number lines above and below illustrate the Save As New function.  
Program 2 has been edited (but not saved) and becomes Program 2*.  The asterisk [*] 
is shown here to indicate that a program has been changed (this is not shown on your 
computer screen when you edit a program).  This program is then saved as Program 15.  
The final result, as shown below, is that Program 15 has been overwritten by Program 
2* and becomes new Program 15*.  The original Programs 2 and 15 no longer exist. 
The file will need to be saved and at that point the changes are finalized. 
 
1   2*   3   4   5   6   7   8   9   10   11   12   13   14   15* 16   17   18   19   20 
 
If you want to keep the original program unchanged (program 2 in this example) use 
the Save As New function first to select a destination program number and then make 
changes. 
 
You can make a duplicate of a program simply by making it the current program and 
then saving it as another program number without making any changes to it.  Just be 
sure that you do not overwrite a program that you want to keep. 
 
 
Downloading a Program’s Data 
 
Configuring Communications 
 

Before you can download the current program, all programs, or a range of programs, 
you must connect your PC to your QubicaAMF lane machine with the supplied 
interface cable and then select the computer’s communications port that will be used 
to communicate with your lane machine.  This is done by selecting 
<Communications> from the <Configure> pop-up menu.  When you do this, the Set 
Communications Port dialog box appears. 
 

Save As
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To set or change the port used to connect to your lane machine, click on the 
appropriate Comm Port radio button.  Note that Comm 1 is selected in the previous 
configuration.  Your computer may not have all of these ports available, but the 
chosen port must match the one to which the interface cable is attached.  Refer to your 
computer’s documentation regarding the designation of the computer’s ports. 
 
Downloading Data 
 

In order to download programs, you must click on the <Download> button on the 
open worksheet. 

 
The Download Program(s) dialog box is displayed. 
 

 
 
To download the current program on the worksheet, click on the <Current Program 
Only> radio button,  then click on the <OK> button or press <ENTER>. 
 
To download all programs in the current work file, click on the <All Programs> 
radio button, then click on the <OK> button or press <ENTER>. 
 
To download a continuous range of programs, click on the <Range of Programs:> 
radio button.  Enter the number of the first program in the range to be downloaded in 
the From Program Number box and the number of the last program in the range to be 
downloaded in the To Program Number box.  You can either use your mouse to enter 
the numbers and move between boxes, or you can tab between boxes and enter the 
numbers directly from your keyboard. 
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When you have completed making your selection, 
click on the <OK> button or press <ENTER>.  The 
programs that you have selected will be downloaded 
to your lane machine.  If you are not connected to 
your lane machine or if the connection is bad or 
incorrect you will receive the following message. 
 
Correct the problem and repeat the downloading procedure. In order to use the new 
program data after completing the download, you must first retrieve the desired 
program using menu function 01 even if the desired program number is the same as 
the lane machine’s current program number.   
 
 
Viewing and Printing Graphs 
 

Century Programmer™ allows the user to 
view and print graphical representations 
of the conditioner profiles and patterns 
for each of the lane conditioning 
programs.  To view a program’s graph, 
select the desired program as the current 
worksheet.  Next, click on <View>, 
<Preview>.  The following window will 
be displayed. 
 
The graph represents the lane surface 
from the foul line to the tail plank as 
viewed from above.  Initially the graph is 
blank.  By clicking on the <Pass 1> and 
<Pass 2> <Forward>, <Reverse>, and 
<Stripping> check boxes, you can view 
a representation of the conditioner pattern 
in layers as they will be deposited on the 
lane surface by the selected program.  
Each layer is presented in a different color or shade.  As you superimpose one layer 
over another, the colors darken to show where the patterns of oil deposition overlap.  
The darker the color, the more conditioner deposited in that area.   
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To the left of the lane diagram is a distance scale, and below the foul line are numbers 
representing typical lane machine oil tank sizes.  In this example the outside tanks are 
seven-inch tanks, the track tanks are three inches each, and the inside tanks are ten 
inches each (outer, track, and center tanks on other machines).  These are the program 
default settings, but Century Programmer™ allows you to set the tank widths to 
match your machine’s tank configuration.  To change these settings, from the graph 
window click on <Configure>, <Wick>.  The following dialog box is displayed. 
 

 
 
Click on the <Up> or <Down> arrows to the right of the tank section boxes to select 
the desired tank widths.  When finished, click on <OK> or press <ENTER>.  For the 
program to accept the changes, the combined width of all the wick sections must 
equal 40 inches.  
 
To print a copy of the current graph, while in the graph window select <File>, 
<Print>.  Century Programmer™ will ask you if you want to include program data on 
the printout.  Selecting YES will result in both the factory.hvo:1 (worksheet file) and 
factory.hvo:2 (graph) screens being included on the printed page.  If you choose this 
option, it is recommended that you first select the landscape mode in Print Setup. To 
return to the worksheet window from the graph window, click on <View>, <Input 
Form>. 
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Other Features 
 
Security 
 

Century Programmer™ allows you to set password protection for access.  To add 
password protection to your programs click <Configure>, <Security>.  The Software 
Security dialog box will appear. 
 

 
 
Click on the <Enable Software Password Security> checkbox. Click <OK> or 
press <ENTER> to accept, or click <Cancel> to return to the previous window 
without enabling password protection.  After clicking <OK>, the following dialog 
box is presented. 
 

 
 
The prompt will be positioned at the beginning of the Enter Password box.  Enter 
your chosen password and click <OK> or press <ENTER>.  A Confirm dialog box 
will appear asking you to confirm your password selection.  Re-enter your chosen 
password exactly as before and click on <OK> or press <ENTER>.  Once the 
program has been closed, the Century Programmer™ will prompt you to enter your 
password before the program will begin again.   
 
To disable password protection, click on <Configure>, <Security> and click on the 
<Enable Software Password Security> check box or in the Software Security box.  
This will remove the check mark.  Click on <OK> or press <ENTER>. 
 
Downloading Messages 
 

When you first energize your lane machine, a message scrolls across the control box’s 
display window. HVO SUMMIT (for Summit machines) is the lane machine’s default 
message.  This is called the Custom Marquee Display.  This message is customizable 
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using Century Programmer™.  For Example, you might want to have the name of 
your bowling center proudly displayed whenever the lane machine is powered up.  To 
change this message, connect the interface cable between your lane machine and your 
computer and power up the lane machine.  Next, run Century Programmer™ and 
select <Configure>, <Message Display>.  The Set Message Text dialog box appears 
as shown below left. 
 
Simply type in your message and click <OK> or press <ENTER>.  The message will 
download and begin scrolling across the lane machine’s display screen.  
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Retrieving Programs and Schedules 
 
If you have created or edited programs or schedules directly on your lane machine, 
you do not have to recreate them on your computer in order to make them available to 
Century Programmer™.  You can retrieve them directly from your lane machine.  To 
retrieve a program or programs, connect your computer to the lane machine with the 
interface cable and power up the lane machine.  Next, start Century Programmer™, 
but close all worksheet windows, leaving Century Programmer™ running.  The 
command line at the top of your screen will give you an option that was not available 
while working in a work sheet or graph screen.  Click on <Transfer>, and a pop-up 
menu appears.  From the list, click on <Retrieve Programs> and the Select Machine 
Type dialog box appears.  

 
Select your machine type from the list by clicking on the applicable radio button, and 
then click <OK> or press <ENTER>.  The Retrieve program(s) dialog box appears. 

 
Click on either the <All Programs> or the <Range of Programs> radio button.  
Choosing Range of Programs activates the From Program Number and To Program 
Number boxes.  Enter the beginning and ending program numbers to be retrieved by 
clicking on the <Up> or <Down> arrows or by entering the numbers directly from 
your computer’s keyboard.  When finished, click <OK> or press <ENTER>. 
 
Century Programmer™ will retrieve the program(s) and display a worksheet on your 
screen.  You should save this work file using the save command giving the file a 
name of your choice.  You can now edit and download these programs as desired. 
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You can also retrieve, edit, and save schedules from your lane machine in the same 
manner.  Simply choose <Transfer>, <Retrieve Schedule>.  The machine’s stored 
schedule will be loaded into Century Programmer™ and displayed on the computer’s 
screen.  You should save this file under a name of your choice also, and then you can 
edit and download the schedule as desired. 
 
Many of the other program features, such as setting up the communications port, 
enabling password security, and changing the lane machine’s custom marquee display 
are available while working in the Scheduler screen. 
 
Scheduler  
 
The HVO Summit has the capability of scheduling and running specific lane 
conditioning programs on selected lanes during specific times of the day.  The lane 
conditioning program can be different from lane to lane and from day to day.  It’s all 
very easy with the Scheduler function.  Century Programmer™ comes with a 
Scheduler file installed.  This file can be edited and expanded to accommodate any 
size bowling center.  To access this function choose <File>, <Open> from the initial 
Century Programmer™ screen.  The File Open dialog box will appear. 
 

Click on the <Drop-down> arrow to the right of the List files of type: box and select 
<Scheduler> from the pop-up menu.  All of the stored Scheduler files will now be 
listed in the large box above the List files of type: box.  Initially the only file that will 
be listed is factory.sch.  Others are added as you either create or retrieve and save 
them.  Click on <factory.sch> to select it.  This file will now be listed in the large box 
and in the smaller File name box above it.  Click on <OK> or press <ENTER> to 
open this file. 
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There are two Scheduler screens (see below).  The FACTORY.SCH:1, is the default 
Scheduler screen, and FACTORY.SCH:2, is the Time Zones screen. 

 

 Factory.sch:1 

 
 
 
 
 
 Factory.sch:2 

 

 

 
 
 

 
The Factory.sch:1 screen shows the Scheduler grid with the days of the week and the 
time zones across the top, and the lanes in numerical order down the left side.  
Scheduler allows you to assign any of the 20 lane conditioning programs to any lane, 
during any of three separate, daily time zones for any day of the week.  This example 
shows that for this hypothetical seven lane bowling center, lane conditioning program 
number 6 is scheduled to be run during the first time  zone on Monday through 
Friday, and that program number 10 will be run during the same time zone on 
weekends. 
 
To change these settings, first save this file under a different filename.  This is the 
factory default read-only file, and Century Programmer™ will not allow you to save 
changes to this file.  To save this file under a different filename, click <File>, <Save 
As> from the command line, and enter a new filename in place of factory.sch.   
 
The factory-supplied schedule is for seven lanes.  Your bowling center is likely to have 
a different number of lanes.  Century Programmer™ easily accommodates up to a 
maximum of 255 lanes.  To change the number of lanes to match your bowling center, 
click <Edit>, <Number of lanes>.  The Edit Number of Lanes dialog box will appear. 
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Enter the number of lanes by using the up or down arrow buttons or highlight the box 
and enter the number directly from your keyboard.  If you build a grid with more 
lanes than can fit on your computer’s screen, a scroll bar will appear on the right side 
of your screen, and you can use this to view any portion of your schedule.  Once you 
have set up the Scheduler to match the number of lanes in your bowling center, 
simply use the Edit pop-up menu as discussed below to complete your schedule.   
 
To modify the schedule, you do not enter data directly in the Scheduler grid.  To edit 
a single lane and time zone, click on <Edit>, <Single> and the Edit Single Schedule 
dialog box appears. 

Click on the <Drop-down> arrows to the right of the various 
boxes and make your selections.  It is necessary to click 
directly on the <Day> and <Time Zone> pop-up selections in 
order to capture them.  To delete a program from a time zone 
slot without replacing it with another program, select the 
applicable <Day>, <Time Zone>, and <Lane> in the Edit 
Single Schedule dialog box, highlight the Program box, and 
type in a “0” (zero).  When finished editing, click <Update 
Schedule>.  The new schedule will appear in the edited slot on 
the Schedule screen (grid).  
 

To edit a continuous range of lanes or time zones, click on <Edit>, <Range>.  The  
Edit Range Schedule dialog box will appear. 
 

This dialog box works similarly to the Edit Single 
Schedule dialog box.  This box has From and To 
sections allowing an entire continuous range of lanes 
to be scheduled at one time.  When editing has been 
completed, click <Update Schedule> to update the 
Scheduler grid. 
 
While the Edit Range Schedule dialog box will 
overwrite an existing schedule, you may want to clear 
a section of an existing schedule.  For example, when 

you are changing the time zone in which lane maintenance is to be performed, you 
will need to clear the previously scheduled time zone or the machine will be 
scheduled to perform lane maintenance twice per day.  Clearing a range is easy.  
Simply select <Edit>, <Clear Range> and enter the applicable data in the Clear 
Schedule Range dialog box.  This box is identical to the Edit Schedule Range dialog 
box except that you do not enter a program number. 
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Time Zones 
 

Century Programmer™ provides you with the ability to schedule lane maintenance 
during three different daily time periods called Timezones.  They are Timezone A, 
Timezone B, and Timezone C.  Century Programmer™ gives you the ability to set the 
start and end times of these time zones to suit your needs.  To set the time zones, click 
<View>, <Time Zones> from the Scheduler FACTORY.SCH:1 screen.  The program 
switches to the Scheduler FACTORY.SCH:2 screen as shown below. 
 

 
 
The screen shows a grid with the days of the week running across the top and 
Timezones A, B, and C along the left side.  Note that the times shown are the starting 
times of the time zones.  The starting time of Timezone A is 0:00, or midnight, the 
beginning of the day.  This starting time is fixed and cannot be changed.  The starting 
times of Timezones B and C can be set to any time subject to the stipulations 
contained below.   
 
The starting time of one time zone is the ending time of the previous time zone.  
There are no gaps between time zones.  To change the start times of the time zones, 
click <Edit>, <Time Zones>.  The Edit Time Zones dialog box will appear. 
 

 
 
Choose the day of the week in the Day box, and then set the start times for Timezones 
B and C.  As you select a start time using the <Drop-down> buttons, the end time of 
the previous time zone will change to equal the start time just selected.  When you 
have finished editing that day’s time zones, click on <Update Time Zones> to apply 
the changes to the time zone grid.  The latest start time on the drop-down list is 23:59, 
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which will show up as 24:00 in the time zone grid.  This is the same as 0:00, or 
midnight.  Repeat this process for the remaining days of the week. 
 
If you attempt to set the start time of Timezone B later than the start time of Timezone 
C, the start time of Timezone C will change to equal the start time of Timezone B.  
Conversely, if you attempt to set the start time of Timezone C earlier than the start 
time of Timezone B, the start time of Timezone B will change to equal that of 
Timezone C.  Since the start times of Timezones B and C would now be the same, the 
duration of Timezone B would be zero and Timezone B would be skipped (along with 
its associated schedule).  For this reason, it is recommended that you allocate 
sufficient time for each time zone in order to accommodate your bowling center’s 
lane maintenance schedule. 
 
To return to the Schedule screen, click <View>, <Schedule>. 
 
When you have completed creating or editing the schedule, save this file using a 
filename other than factory.sch.   
 
The file can be downloaded to your lane machine using the download feature from 
within Scheduler.  To do this, establish a connection between your computer and the 
lane machine; start Century Programmer™; and open your Scheduler file.  Finally, 
select <Download>, <Schedule> from either of the two main Scheduler screens. 
 
 

Using Help 
 
Help can be used to find out more information about a given topic, window, lane 
program parameter, or CPWIN function.  There are several methods for obtaining 
help from within Century Programmer ™.  These methods are: 
a) Help Index 
b) Help Search 
c) Help Hypertext Links 
d) Context Sensitive Help 
 
To access Help, click on <HELP> in the main menu.  The Help drop-down menu 
appears showing the three available selections.  The bottom selection, About 
CPWIN… is simply a statement that shows the version of CPWIN software you are 
using as well as the toll free Customer Service telephone number. 
 
If Using Help is selected, three tabs appear: Contents, Index, and Find or Search 
depending on the version of Windows® you are using.  Each tab functions as a 
different method of navigating through Help.  Accessing the Contents tab presents 
you with a number of Windows® help functions.  These items contain all the 
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information necessary to fully understand, utilize, and customize Help.  Reading the 
information contained there is one way of becoming familiar with Help. 

Help’s Help Index 
 

The next tab is the Index tab.  Using this feature you can find information on how to 
use Help simply by typing in the name or title of the help topic.  As you type, Help 
moves the cursor to the topic that it determines most closely matches what you have 
typed.  Often Help will have selected the desired subject before you have finished 
typing in its name.  Of course, you can also scroll to the desired topic.  Once the 
desired topic has been found, click <Display> to access a dialog box that explains the 
selected help topic. 
 

Help Search 
 

The third tab is the Find (or Search) tab.  Use this tab to find help information when 
you don’t know the exact terminology of the help function you are trying to locate.  
When you type in a keyword or words, a list of subjects is provided to help narrow 
the search.  This list changes depending on what you have typed, if anything, in the 
keyword field.  The nice thing about this feature is that it attempts to match related 
words with a help topic.  This means that you can locate the topic by selecting a word 
to pinpoint the topic even though the word itself is not in the name or title of the topic.   
 
There are also a number of options for you to choose from in setting up the 
parameters of the search.  By clicking on the Options button you can choose how 
Help looks at what you type in the keyword field.  Help can look for words that begin 
with, contain, end with, or match the words or letters you type in the first field.  It can 
search for a group of words in any order or it can look for any word within a group of 
words.  It’s a very powerful tool. 
 
The first time you use the Find Help function, you will be prompted to create a data 
base.  You will be presented with several choices.  Simply select the one you want, 
and in a few seconds you’re in business.  You can rebuild the data base by clicking on 
the Rebuild button from the opening Find screen. 
 

Help Hypertext Links 
 

You may notice that when you use the index or search functions to select a topic, an 
information dialog box appears with information about the subject.  Some of the 
words may be a different color than the rest of the text.  They are also underlined for 
identification when using a monochrome monitor.  When you place the cursor over 
one of these words, the cursor changes to a hand.  This indicates that this is a 
hypertext link.  Clicking on the word takes you directly to more information about 
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that particular word or phrase.  These links help you to better understand the various 
functions available without having to stop what you are doing to look it up.  Clicking 
Back takes you back to the point you were at before clicking on the word.  Clicking 
on Help Topics returns you to the opening Help dialog box. 
 

Context Sensitive Help 
 

If you have chosen to view the Status Bar from the View drop-down menu, you will 
notice a message at the bottom of the screen. It states: For Help, press F1.  Pressing 
F1 brings up the context sensitive help screens.  These screens help you to understand 
the functions of the various CPWIN buttons, menus, and dialog boxes to help you use 
the various CPWIN program features.   
 
You can also access the context sensitive help screens by clicking on the pop-up Help 
button on the Tool Bar.  The button looks like a question mark with an arrow next to 
it.  When you click on this button, a large question mark appears next to the cursor.  
Move this cursor to the box or button that you want help information on, and click.  
The context sensitive dialog box will appear. 
 

CPWIN Help  
 

The last Help area to discuss is the first item on the Help drop-down menu.  It is 
simply called Index.  This index differs from the help index discussed earlier in that 
the listed items are specific to learning to use CPWIN, whereas the first help index 
described earlier lists items specific to learning to use Help itself.  This index consists 
of a list of general topics from which you make the desired choice.  All the items in 
the list are hypertext items, and selecting one takes you to a more specific list.  
Clicking on one of the more specific items takes you to the information screen for that 
item.  Often there are additional hypertext items to help you understand the topic 
better.  To return to the previous level, click on the <Back> button.  To return to the 
initial list from any level, click on the <Contents> button. 
 
As discussed earlier in Help’s Help Index and Help Search, there is also a help 
search feature that utilizes a CPWIN Search index and a CPWIN Find data base.  The 
first time you attempt to use the data base, Help will have to create it.  From then on, 
it’s readily available, or it can be rebuilt to new specifications. 
 
To become more familiar with Help’s features, you should try using Help.  Help is 
designed to be its own teaching tool, and there is no substitute for just browsing and 
exploring. 
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References 
 
This chapter presents a detailed reference of important aspects of Century  
Programmer software. 
 
Open command (File menu) 
 

Use this command to open an existing file of programs in a new window.  You can 
open multiple files of programs at once.  Use the Window menu to switch from one 
open program file to another.   
 
Shortcuts 

Toolbar:  
Keys: CTRL+O 

 
 

Close command (File menu) 
 

Use this command to close all windows containing the active file of programs.  
Century Programmer™ suggests that you save changes to your program file before 
you close it.  If you close a file of programs without saving, you lose all changes 
made since the last time it was saved.   
 
You can also close a program file by using the Close icon on the document's window, 
as shown below: 
 

Mouse: Click on the program file’s Control Menu button.     

     

Keys: CTRL+F4  
 
 

Save command (File menu) 
 

Use this command to save the active program file to its current name and directory.  If 
you want to change the name and directory of an existing program file before you 
save it, choose the Save as command 
 
Shortcuts 

Toolbar:  
Keys: CTRL+S 
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Save As command (File menu) 
 

Use this command to save and name the active program file. Century Programmer™ 
displays the Save as dialog box so you can name your program file.   
 
To save a program file with its existing name and directory, use the Save command. 
 
 

1, 2, 3, 4 command (File menu) 
 

Use the numbers and filenames listed at the bottom of the File menu to open the last 
four program files you closed.  Choose the number that corresponds to the program 
file you want to open. 
 

 
Exit command (File menu) 
 

Use this command to end your Century Programmer™ session.  You can also use the 
Close command on the application Control menu.  Century Programmer™ prompts 
you to save documents that have unsaved changes. 
 
Shortcuts 

Mouse: Click the application's Control Menu button. 

    

Keys: ALT+F4 
 
 

Preview command (View menu) 
 

Use this command to display a graphic view of a lane conditioning program’s oil 
deposition pattern. 
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Click    To 

 To display current pattern for pass 1 forward run. 
 

 To display current pattern for pass 1 reverse run. 
 

 To display current pattern for pass 2 forward run. 
 

 To display current pattern for pass 2 reverse run. 
 

 To add stripping to the current pattern. 
 
To return to the Work Screen, select <View>, <Input Form>.   This closes the Graph 
File screen and returns you to the Work Screen. 
 
Shortcuts 

Mouse: Click on the graphic page’s file’s close icon. 

     

Keys: CTRL+F4  
 
 
Toolbar command (View menu) 
 
Use this command to display or hide the Toolbar, which includes buttons for some of 
the most common commands in Century Programmer™, such as File Open.  A check 
mark appears next to the menu item when the Toolbar is displayed. 
 

 
 
The toolbar is displayed across the top left area of the application window, below the 
command line or menu bar.  The toolbar provides quick mouse access to many tools 
used in Century Programmer™.   
 
To hide or display the Toolbar, choose < View>, <Toolbar>. 
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Click To 

 Open an existing document.  Century Programmer™ displays the Open 
dialog box, in which you can locate and open the desired file. 

 Save the active document or template with its current name.  If you have 
not named the document, Century Programmer™ displays the Save As 
dialog box. 

 

 Print the active file.. 
 

 
Display copyright notice and version number of Century Programmer™. 

 Context sensitive help command to obtain help on some portion of Century 
Programmer™. 

 
 

Status Bar command (View menu) 
 

Use this command to display or hide the Status Bar, which describes the action to be 
executed by the selected menu item or toolbar button, as well as the keyboard latch 
state. The Status Bar appears at the bottom of the program screen.  A check mark 
appears next to the menu item when the Status Bar is displayed. 
 

 
 

To display or hide the status bar, choose <View>, <Status Bar>. 
 
The left area of the status bar describes actions of menu items as you use the arrow 
keys to navigate through menus.  This area similarly shows messages that describe the 
actions of toolbar buttons as you depress them, before releasing them.  If, after 
viewing the description of the toolbar button command, you wish not to execute the 
command, then move the pointer off the toolbar before releasing the mouse button. 
 
The right area of the status bar shows which of the following keyboard keys are 
latched down: 
 
Indicator Description 
CAP The Caps Lock key is latched down. 
NUM The Num Lock key is latched down. 
SCRL The Scroll Lock key is latched down. 
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Communications command (Configure menu)  
 

Use this command to select the communications (Comm) port on your computer that 
you will use to communicate with your lane machine. 
 

Cascade command (Window menu) 
 

Use this command to arrange multiple opened windows in an overlapped fashion.  
 

Tile command (Window menu) 
 

Use this command to arrange multiple opened windows in a non-overlapped fashion. 
 

Arrange Icons Command (Window menu) 
 

Use this command to arrange the icons for minimized windows at the bottom of the 
main window.  If there is an open document window at the bottom of the main 
window, then some or all of the icons may not be visible because they will be 
underneath this document window. 
 

1, 2, ... command (Window menu) 
 

Century Programmer™ displays a list of currently open document windows at the 
bottom of the Window menu.  A check mark appears in front of the document name 
of the active window.  Choose a document from this list to make its window active.   
 

Index command (Help menu) 
 

Use this command to display the opening screen of Help.  From the opening screen, 
you can jump to step-by-step instructions for using Century Programmer™ (CPWin) 
and various types of reference information.   
 

Once you open Help, you can click the Contents button whenever you want to return 
to the opening screen. 
 

Using the Help command (Help menu) 
 

Use this command for instructions about using Help. 
 

About command (Help menu) 
 

Use this command to display the copyright notice and version number of Century 
Programmer™. 
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